


 

 

 
 
 

 

 

 

 
 

 

President and CEO 
Laura Stack, MBA, CSP, CPAE, is best known by her moniker 
“The Productivity Pro®.” Laura is an award-winning keynote 
speaker, bestselling author, and noted authority on employee and 
team productivity. She is the president of The Productivity Pro, 
Inc., a boutique consulting firm dedicated to helping leaders 
increase workplace performance in high-stress environments. 
Laura is a past President of the National Speakers Association. 
 

Keynoter 
For over 25 years, Laura’s keynote speeches and seminars have 
helped associations and Fortune 1000 corporations improve 
output, increase speed in execution, and save time in the office. 
She is a high-energy, high-content speaker, who educates, 
entertains, and motivates professionals to deliver bottom-line 
results. Laura is a member of the prestigious CPAE Speaker Hall of 
Fame, which has fewer than 200 members worldwide) and holds 
the Certified Speaking Professional (CSP) designation. 
 

Author 
Laura is the bestselling author of seven books published by 
Random House, Wiley, and Berrett-Koehler, including her 
newest, Doing the Right Things Right: How the Effective Executive 
Spends Time (Jan. 2016). Laura’s books have been published in 
more than 20 foreign editions, and she is a featured columnist for 
the American Business Journal, LinkedIn, Time Management, and 
Productive magazines. Laura has produced more than 50 online 
training programs. 
 
Recognized Productivity Expert 
Laura has been featured nationally on the CBS Early Show, 
CNN, NPR, Bloomberg, the New York Times, USA Today, the 
Wall Street Journal, Entrepreneur, and Forbes magazine. Laura 
has been a spokesperson for Fellowes, Microsoft, 3M, Skillsoft, 
Office Depot, Day-Timer, and Xerox. Her client list includes 
top Fortune 500 companies, including Starbucks, Wal-Mart, 
Aramark, Bank of America, GM, Wells Fargo, and Time Warner, 
plus government agencies such as the Internal Revenue Service, 
the United States Air Force Academy, the Census Bureau, the 
U.S. Senate, and the Department of Defense. 
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Celebration 
 
“What homework did I do since the first session to get better (IMPROVEMENT)?” 
 

 
 
 
 

 

AH-HA! 
 
 “What has changed for me since attending this session today?” (AWARENESS) 
 

 
 
 
 

 

Goal Setting 
 

“Here’s what am I going to DO to ensure that real change actually does take place in my 
life (BEHAVIOR CHANGE).” 
 

 
 
 
 

 

Homework 
 
 “Here are the specific things I will complete before the session next week.” (ACTION) 
 
1. Send yourself several emails and practice moving them to Tasks and Calendar.  
2. Drag some Sent Items to Tasks to understand the difference between copying and 

moving email. 
3. Drag some Tasks to your Calendar to practice blocking time to work. 
4. Teach someone else about Tasks. Have them experiment with you on the Assign 

Task function to see how it works. 
5. Go through the screen shots from this workbook and practice your new skills! 
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Using Tasks with Email 
 

A. Convert an Email into a Task.  
 

1. Open an email. 
2. From the Move group, click the Move button. (You can also right-click from the 

inbox). 

 
 
3. Select Tasks from the list (or Other Folder if you’ve not done this step before). 
4. Click OK. 
5. This will create a new Task. The text of your email will be in the text portion of 

the Task. At the very bottom of the text field, you will see an envelope. This is 
your original email with all attachments. 

6. Update all of the information accordingly (use the Start Date to indicate when 
you want the Task to appear on your To-Do Bar under your Today flag). You can 
set a reminder here, type notes to yourself, insert files, etc. 

7. Click the “Save and Close” button. The email will be moved from your Inbox to 
your Tasks (the original is in your Deleted Items if you want to file it). 

 
Does flagging an email create a Task? NO! It simply adds a reminder to the message 
with a hyperlink in the To-Do bar. If you reply and clear the flag, the to-do is gone, but 
the email remains in the Inbox. This is how email piles up!  
 
B. Convert an Email into an Appointment/Meeting. 
 

1. Open an email as usual.  
2. Click the Move button.  
3. Select Calendar from the list. 
4. This will open a new Appointment. You’ll notice your email text is included. 

Scroll to the very bottom of the text portion, and you’ll see an envelope icon—
this is your original email with any attachments. 

5. Update the appointment information as applicable. 
6. Click the “Save and Close” button.  

 
Hint: Alternatively, you can right-click on an email in your Inbox and select Move. However, 
you will still have the email in the task but won’t see the text of the email message. (I like the 
above way better.) 
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C. Assign an Email to Someone Else and Track It. 
 

1. Move the email to a Task (as in A above). 
2. In the Manage Task group, select Assign Task. 
 

 
 
3. Select the delegate using the TO field (just as you would with an email). 
4. Enter the task in the Subject field. 
5. Enter the desired Start Date and Due Date. 
6. Attach any files needed for the task. 
7. Type a message with instructions in the Note area. 
8. Make sure the “Keep an updated copy of this task on my task list” and “Send me 

a status report when this task is complete” boxes are checked. 
 

 
 

9. Click Send. 
 

NOTES: The recipient can either Accept or Decline your task request, just like a meeting 
request. If accepted, it goes right to Tasks. They now own it, and you can’t make 
changes. If they decline it, you’ll see it back in your task list.  
 
D. Group Assigned Tasks by Person Responsible. 
 

1. Click on Tasks. 
2. Go to the Current View Group and expand the menu. 

(Or click the View tab and select Change View under the 
Current View group). 

3. Click Assigned. 
4. Open and close the tasks for each person as desired to 

view. 
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E. Send a Status Update to the Assignor. You can periodically know the person 
how you’re progressing on a task (personal or assigned): 

 
1. Open the Task. 
2. Under the Manage Task group, select Send Status Report. 

 

 
 

3. Fill in the TO field. 
4. Type a note to the person as usual.  
5. Click Send.  

 
F. Share Your Tasks With Others. Perhaps you want a co-worker to be able to 

see your Tasks, or a group of people all share a “pool” of master tasks. You can 
easily share your Tasks, just as you share your calendar. 
 
1. Right click on Tasks. 
2. Select Share and then Share Tasks. 
3. Fill in the person’s name you wish to share with and click Send. 
4. When they accept, they may now open your Tasks. Click File, Open & Export, 

Other User’s Folder.  
5. Type the name and change the Folder type to Tasks. 

 
G. Block Out Time on Your Calendar to Work on a Task. 

 
1. Open your Calendar to the day you want to schedule. 
2. Click on a Task from your To-Do Bar and drag it to your calendar to “block” it. 

This will make a COPY of the task on your calendar. (If you don’t get to it, do not 
bother to delete from your Calendar, because the Task will roll forward.) –OR– 

3. Open the Tasks on the bottom by clicking the arrow on the right. 
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4. Right-click on the Show tasks on: and select By State Date and unselect Show 
Completed Tasks. 

5. Click and drag a Task up to your calendar to put a block on your calendar to 
work on that particular task. If you don’t get to it, just leave it (no need to 
delete—the task will be there the next day). 

 
H. Create a New Task from an Appointment. Let’s say you have some work to 

do to prepare for an upcoming meeting. You need to create a Task but don’t want to 
manually include all the information you’ve already entered into your calendar. 

 
1. Open your calendar to view the appointment.  
2. Click and drag the appointment to Tasks. 
3. A new Task will automatically open with the appointment information copied 

into the text portion of that Appointment. 
4. Fill out the relevant information (Start and Due dates, etc.) 
5. Save and close. 

 
I. Create a Meeting from Inside an Email. 
 

1. Open an email. 
2. Under the Respond group, select Meeting. 
3. Fill in the applicable information and click Save and Close. (Note: this makes a 

copy. You’ll still have to delete the email from the inbox. Alternatively, you can 
Move the Email to the Calendar before inviting attendees.)  
 

J. Turn off your email previews. You can process more quickly if 
you don’t stop to read the first few lines of an email and get distracted 
from your task (promotes skimming). Turn OFF the Message Preview! 

 
1. Click the View tab. 
2. From the Arrangement group, select Message Preview. 
3. Select Off. Good job! 

 
K. Use Draft Emails as a Reminder. If you think of someone you need to email 

but don’t have time right now: 
 

1. Begin a New email as usual, filling in the name and subject. (Or hit Reply to a 
message in your inbox.) 

2. DON’T send it. Hit the Save icon (the disc button) in the Quick Access Toolbar. 
3. Close the E-mail, and the email will now be in your Drafts folder. (Note: this is a 

dangerous practice if you don’t commit to sending all drafts each day.) 
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L. Resend a Sent Item. If you don’t hear back from someone on a message you 
sent, you were having email problems, etc., sometimes you just want to send the 
exact same message without forwarding it: 

 
1. Click on the Sent Items. 
2. Locate the email using the Search box. 
3. Open the message. 
4. Under the Actions button in the Move group, select Resend this Message. 
5. Make any changes in name, email address, text, etc. 
6. Click Send. 

 
M. Use Sent Items to Set a Reminder. If you sent someone an email and are 

worried that they won’t reply or want to remind them about a deadline: 
 

1. After sending the original email, go to your Sent Items (it will be the first entry in 
the list if sorting by the Sent field). 

2. Drag the email to Tasks, which creates a new Task that has a copy of the email in 
the text field. 

3. Do not set a Start Date or Due Date (this isn’t actually a “to-do”; it’s a reminder). 
4. Click the Reminder box and set a day and time. (I keep my reminders set for 9:00 

AM, so I get all of them at once, creating a quasi-to-do list.) 
 
N. Send a Previously Sent Item as an Attachment. If you receive an email 

saying “you never sent me such and such,” but you really did, you can send a copy 
of the original back as proof! You’ll reply back, saying, “My previous email is 
attached; notice the date of xxx.” 

 
1. Reply to the message as you normally would. 
2. Click the Insert tab. 
3. Click the Outlook Item button in the Include 

group. 
4. Make sure the radio button on the right is 

checked to send as Attachment. 
5. Select the Sent Items folder. 
6. Sort by the TO field and locate the original 

email. 
7. Double click the email to attach. 
8. Click Send. 
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Educational Resources by Laura Stack 
 

Screenshots of Microsoft Outlook Tips and Tricks: www.TheProductivityPro.com/Laura  
 
200+ Microsoft Outlook online training videos: www.TheProductivityPro.com/Outlook. Use coupon 
“Outlook20” for an additional $20 off! 
 
What to Do When There’s Too Much to Do book site: www.TheProductivityPro.com/whattodo  
 
Execution IS the Strategy book site: www.ExecutionIsTheStrategy.com  
 
SuperCompetent book site: www.SuperCompetentBook.com  
 
Doing the Right Things Right book site: www.3TLeadership.com  
  
Laura’s YouTube channel: www.youtube.com/theproductivitypro  
 
Subscribe to our weekly one-minute personal productivity video training series “The Productivity 
Minute”: www.theproductivityminute.com/   
 
Link with me! www.linkedin.com/in/laurastack 
 
Follow me on Twitter: www.twitter.com/laurastack  
 
Become a Fan of The Productivity Pro®: www.facebook.com/productivitypro  
 
Sign up for my free monthly newsletter, The Productivity Pro®: 
www.theproductivitypro.com/subscribe/  
 
Subscribe to my blog: www.theproductivitypro.com/blog/ 
 
Laura’s website has over 150 free articles for download: www.TheProductivityPro.com/articles  
 
FREE downloadable worksheets, checklists, and resources: www.theproductivitypro.com/free/  
 
Take the quizzes FREE from Laura’s books: www.theproductivitypro.com/quizzes/  
 
Get a FREE tip of the day via email: www.theproductivitypro.com/tip-of-the-day/  
 
Resources for purchase (books, CDs, DVDs, self-study audio, video training, MP3s etc.): 
www.theproductivitypro.com/products-page/  
 
Laura Stack keynotes: www.TheProductivityPro.com/keynotes  
 
Laura Stack training: www.TheProductivityPro.com/training  
 

 
I would welcome the opportunity to come to your organization to give a seminar or speak at an 

upcoming meeting! Please reach out to me anytime at Laura@TheProductivityPro.com. 
 


